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COPYRIGHT INFORMATION 
FEDERAL COPYRIGHT LAW PROTECTS THIS SOFTWARE.  COPYING THE SOFTWARE FOR ANY REASON OTHER THAN TO MAKE 
A BACKUP IS A VIOLATION OF LAW.  INDIVIDUALS WHO MAKE UNAUTHORIZED COPIES MAY BE SUBJECT TO CIVIL AND 
CRIMINAL PENALTIES. 

Farm Trac X2 Reference Guide (Version 12.0 and higher for Microsoft® Windows® Operating Systems) copyright© 2006 Farm Works 
Software®, a division of CTN Data, LLC  All rights reserved.  This document is the property of Farm Works Software. This document, as well 
as the software described in it, are furnished under license and may only be used in accordance with the terms of such license.  Except as 
permitted by such license, no part of this document may be reproduced, stored in a retrieval system, or transmitted by any means, electronic, 
mechanical, photocopying, recording, or otherwise, without written permission from Farm Works Software®.  All use, disclosure, and/or 
reproduction not specifically authorized by Farm Works Software® are prohibited. 

The information in this document is provided for reference only.  Although every precaution has been made to make the material herein as 
complete and accurate as possible, no warranty or fitness is implied, nor is any liability assumed for errors or omissions.  The information 
provided is on an "as-is" basis.  Farm Works Software®, CTN Data, LLC, and the creators of this document shall have neither liability nor 
responsibility to any person or entity with respect to any loss or damages arising from the information contained herein or from the use of the 
CD or programs accompanying it.  Neither is any patent liability assumed with respect to the use of the information contained in this 
document. 

All terms mentioned in this document that are known to be trademarks, registered trademarks, or service marks have been appropriately 
capitalized.  Farm Works Software and CTN Data, LLC cannot attest to the accuracy of this information.  Use of a term in this document 
should not be regarded as affecting the validity of any trademark, registered trademark, or service mark.   

Farm Works Software, copyright© 1992-2006, is a registered trademark of CTN Data, LLC All rights reserved. 

SOFTWARE LICENSE AND LIMITED WARRANTY 
LICENSE: THIS SOFTWARE IS LICENSED UNDER THE FOLLOWING TERMS AND CONDITIONS, CONTINUING WITH THIS 
INSTALLATION INDICATES THAT YOU HAVE READ AND UNDERSTAND THIS SOFTWARE LICENSE AND LIMITED WARRANTY AND 
THAT YOU AGREE TO THESE TERMS AND CONDITIONS. IF YOU DO NOT AGREE TO ANY OF THEM, IMMEDIATELY RETURN THE 
PACKAGE FOR A REFUND. 

CTN Data, LLC (CTN) grants you a personal, non-exclusive, non-transferable license to use the enclosed software and user manual, 
("Software") in accordance with the terms of this license. Title to and all rights in the Software remain with CTN. You agree to protect the 
Software against unauthorized use and disclosure. You will not copy the Software or any part thereof for any reason other than for backup 
purposes. Modifying of this Software in any way is strictly prohibited without the expressed written consent of CTN. You may not disclose, 
transfer, or otherwise make available the Software, in any form, to anyone without the prior written consent of CTN. 

TERM: This license is effective upon opening the package, and shall automatically terminate if you breach any of the terms and conditions 
herein. Upon such breach, you agree to destroy all copies of the Software and discontinue use thereof. 

Limited Warranty: The Software is sold "AS IS". You assume the entire risk as to the selection, result, and performance of the Software.  
However, CTN warrants the magnetic diskette or CD on which the Software is recorded to be free from defect in material and workmanship 
under normal use for a period of ninety (90) days from the date of original purchase. Upon proof of purchase, CTN will replace a defective 
diskette or CD at no cost, (except for the cost of shipping, which will be paid by the Purchaser). YOUR SOLE AND EXCLUSIVE REMEDY IN 
THE EVENT OF DEFECT IS EXPRESSLY LIMITED TO REPLACEMENT OF THE DISKETTE OR CD, provided that the diskette or CD has 
not been abused in any way.   

THIS LIMITED WARRANTY CONSTITUTES YOUR SOLE AND EXCLUSIVE REMEDY AND THE SOLE AND EXCLUSIVE LIABILITY OF 
CTN AND IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING, BUT NOT LIMITED TO, ANY 
IMPLIED WARRANTY OR MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE AND ALL OTHER OBLIGATIONS OR 
LIABILITIES OF SELLER. IN NO CASE IS CTN LIABLE FOR SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES OR 
FOR LOST DATA. 

You many not sublicense, assign or transfer this license, the program or the related documentation, and any attempt to do so is void. This 
agreement is governed by the laws of the State of Indiana, where any claims arising hereunder shall be litigated. This agreement is for a 
license of intellectual property, and not for the sale of goods (even though some tangible items may be provided) and not governed by the 
Uniform Commercial Code. 

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT AND AGREE TO BE BOUND 
BY ITS TERMS AND CONDITIONS. YOU FURTHER AGREE THAT IT IS THE COMPLETE AND EXCLUSIVE 
STATEMENT OF THE AGREEMENT BETWEEN US WHICH SUPERSEDES ANY PROPOSAL OR PRIOR AGREEMENT, 
ORAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN US RELATING TO THE LICENSING OF 
SOFTWARE FROM CTN.
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Overview of the Mate Programs  
 
Farm Works Mate programs work with hand held PCs running the WindowsTM CE or 
Pocket PCTM operating systems, as well as laptops, the Titan RT, and Titan RH. Farm 
Site Mate works with a GPS receiver for mapping, scouting, and controlling many 
commonly used variable rate applicators. Guide Mate also works with a GPS receiver to 
give you parallel guidance on the screen of your device. By combining Site Mate, Trac 
Mate, and Guide Mate, farm producers finally have a low cost solution to meet all of their 
needs on one device. 

Trac Mate Overview 
 
Farm Trac Mate works with Farm Trac+ and Site Pro to provide you with the ability to 
enter crop and chemical records while in the field. Trac Mate includes the following 
features: 
 

• Works with Farm Trac+ and Site Pro so information, such as field names, 
equipment, personnel, and supplies, may be downloaded from your desktop 
computer and into Trac Mate. 
 

• Includes an easy to use configuration process for adding new fields, personnel, 
equipment, and supplies while away from your desktop computer. 
 

• An integrated time clock can calculate hours worked by each person on an 
operation. 
 

• Use the on-screen keyboard or the handwriting features of Pocket PCs to enter 
information. Trac Mate has been designed to minimize the amount of required 
data entry. Most information is easily entered by selecting items from a list of 
choices on the screen. 
 

• Use the metered feature to keep track of items such as tach hours. Simply enter 
the meter reading at the start of the operation and again after the operation is 
completed. Trac Mate will calculate the amount used on this operation as well as 
default the starting value for the next operation. 
 

• Detect possible calibration problems in the field by entering the total quantity of 
each supply used and have Trac Mate calculate the actual rate applied for each 
supply. 
 

• Record Field and Weather conditions at the time of application for required 
chemical reporting. 
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• Use the Notes area to enter information such as observations about broken tiling, 
weed or insect problems, or anything that will help you to manage your farm 
more efficiently. 
 

• Updates permanent records by simply plugging the device into your desktop 
computer (or swapping the usb drive on a Titan RT) and starting the 
synchronization process from Farm Trac+ or Site Pro. All of your field histories, 
EPA records, and enterprise statements will be updated. If you are using Farm 
Fund$, this will even update your supply inventories. 
 

• Trac Mate can also be used in conjunction with Site Mate and Guide mate to give 
even more functionality and you won’t even know you are running more than one 
program! 

Site Mate Overview 
 
Farm Site Mate offers three integrated modules for basic mapping, scouting, and variable 
rate control. The program works with ArcView Shape Files so that data can be used with 
any geographic information system (GIS) program.  

Basic Farm Site Mate Module 
• Displays multiple layers of ArcView Shape Files for location reference. 

 
• Maps wet holes, weed and insect infestations, and other areas of interest. 

 
• Allows you to drive around the field and generate an accurate map of field 

boundaries. 
 

• Logs the locations of soil samples and other important points in the field. 
 

• Allows you to offset logged paths and boundaries for when you cannot drive right 
on the item being mapped. 
 

• Includes easy to use zoom features for zooming in on important areas of your 
maps. 
 

• Works in US or Metric measurements. 
 

• Works with any GPS receiver capable of outputting NMEA0183. 
 

• Includes a “Data” tab that can be used for displaying information being output by 
your GPS receiver for diagnostics. 
 

• Displays distances of mapped paths, useful for determining lengths of field tiling. 
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• Displays sizes of mapped areas such as field boundaries and weed areas. 

Scouting and Sampling Module 
• Allows you to create soil sampling grids to any size, pattern, and orientation. Site 

Mate can automatically assign sample IDs to each point. 
 

• Allows you to display text with areas, lines, and points. 
 

• Lets you enter an unlimited number of attributes such as scouting notes for 
mapped areas and points. 
 

• Includes navigation tools for navigating to gridded points or any known point in a 
field. 
 

• Includes features for creating and displaying legends for areas, lines, and points. 

Variable Rate Control Module 
• Works with commonly used variable rate controllers. 
 
• Creates “as applied” maps when working with most controllers. 
 
• Gives you the ability to create a legend based on application rate. 
 
• Displays total expected amount of product to be applied. 
 
• Allows you to enter your swath width in order to see an application coverage map 

on the go. 

Guide Mate Overview 
 
Guide Mate provides guidance control and display for swathing applications. Guide Mate 
receives position, speed over ground (SOG), and course over ground (COG) from a 
DGPS receiver. Guide Mate then compares the COG and position to the desired swath 
pattern and produces a guidance display. 
 

• Advanced navigation with “driver friendly” on screen steering graphics, acreage 
calculations, and numerous driving patters (straight A-B, multiple contour modes, 
multiple headland modes, spiral, etc). 

 
• Moving map display shows application accuracy while in the field. 
 
• Acreage calculator during guidance mode. 
 
• Pan and zoom features show close up view to detect gaps and over spray 

conditions. 
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• Can be used in conjunction with a Raven lightbar to control the lightbar. 

 
• MicroGuide can be added for additional guidance support 
 
• Will control Smartrax and Quicktrax autosteer systems. 

 

Using a WindowsTM CE Device 
 
If using the Farm Mate programs with a WindowsTM CE device, you 
will need to  configure your CE device and desktop computer to work 
together. The appropriate software must be installed and a partnership 
between the CE device and the desktop must be created. If installing to 
a laptop/desktop platform, skip to the Installation section of this 
manual. 
 
Note: There are frequent model changes for CE devices. Though every attempt has been 
made to have these instructions as comprehensive as possible, it may be necessary to 
reference the CE device user manual for some instructions. 
 

Creating a partnership between the CE device and the 
desktop computer / laptop 
 
Creating a partnership allows the desktop computer and the CE device to communicate 
back and forth to each other. This communication is how the two computers will 
exchange information and how software will be installed onto the CE device. A new 
partnership must be crated before the CE device may be used with a desktop computer. 
The basic steps for creating a partnership are as follows: 
 

1. Connect the cradle (also known as a docking station) or cable of your CE device 
to your desktop computer or laptop. This will normally plug into a serial or USB 
port on your computer. An adapter may be required. 

 
2. Install Microsoft WindowsTM CE Services (ActiveSync) from the Microsoft 

WindowsTM CE CD-ROM. This CD should be packaged with your CE device. 
This program will run a setup wizard that will step you through installing the 
necessary applications. You may also need your original Windows installation 
CD. You can also find the software by searching the web for Microsoft 
ActiveSync. You must, however, be careful of the software version you 
download. 

 
3. After WindowsTM CE Services (ActiveSync) has been installed, you may be 

prompted to restart your desktop computer. After restarting, place your CE device 
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into the cradle. The New Partnership Wizard should now appear. Enter 
additional information such as a Device Name for your CE device. The device 
name is how your CE device will be identified in WindowsTM. After entering this 
information, the partnership will be complete. 

 
Each time you put your CE device into the cradle or connect the cable, a message 
window will be displayed that indicates that WindowsTM is connecting to the CE device. 
This process is critical, as it is what allows communication between the desktop/laptop 
and the CE device. 
 

 
 

Re-setting the CE Device 
 
If at anytime the software “locks-up” and the CE device will not respond to any of the 
buttons, use the stylus and press the soft reset button. It is not a bad practice to do this 
once a day. 
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Getting Started 
Installing the Farm Works Mate Programs 
 
The mate programs will be installed using the CD-ROM in your desktop or laptop 
machine regardless of whether the program will be run from the desktop, laptop, or CE 
device. If the mate programs will be run from a CE device, the CE device must be 
synchronized with the desktop machine throughout the installation process. 
 
There are two important notes before you start installing your software: 
 

• The files on all Farm Works installation CDs are compressed, so you cannot 
install Farm Works by copying the files. 

 
• Choosing Cancel during installation halts the process and Farm Works will not be 

properly installed on your computer. 

Installation Procedures 
 

1. Insert the Farm Works CD into the appropriate CD-ROM drive. WindowsTM will 
automatically begin the installation process for you. If the installer does not start 
itself, choose Run from the Start menu and then type D:\Setup in the box under 
the command line. (substitute “D” for the letter of your CD drive) Select OK. 

 
2. Select Install Farm Works Mate Programs from the installation screen and then 

select the programs that you wish to install. Most programs will require a cd-key 
or code in order to be installed. Code numbers will default to those previously 
entered if the selected programs have been installed in the past, but can be 
changed if necessary. These codes are packaged with each program that is sold. 
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3. Follow the instructions on the screen to complete the installation process. 
 

4. After the program has been installed, a message will appear alerting you that the 
software has been successfully installed. You can now Exit the installation 
window. 

 
5. If installing to a desktop or laptop, you may want to reboot the computer and if 

installing to a CE device, you will want to perform a soft reset. 
 

Registering Your Software 
 
To protect your copy of the mate programs and to receive information on future updates 
to the program, you must register it under the owner’s name with a registration number 
provided by Farm Works. Registration takes just a few moments to complete and there 
are two options available for receiving registration numbers. 
 

1. On-line registration 
 

1. Go to www.farmworks.com/register 
 
2. Select the programs you have installed. 

 
3. Enter the Machine ID that is displayed on your screen, along with your cd 

key numbers and select Submit. 
 

4. Fill in your contact information, the place of purchase, and select Submit 
Registration. If you have completed the information correctly, you will 
receive an e-mail containing your registration numbers within an hour. 

 
2. Call Farm Works Software 
 

http://www.farmworks.com/register
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1. Call 1-800-225-2848 Monday – Thursday 8AM – 8PM EST 
Friday 8AM – 6 PM EST 
Saturday 8AM – Noon EST 

 
2. Make sure to have the Machine ID number ready or have the registration 

window brought up before calling. 
 
Note: If the registration window does not appear upon opening the Mate programs, it 
may be located by going to File > About Farm Site Mate… > Registration Info within 
the Mate program. 
 
When you receive the registration number(s), enter them into the correct registration 
boxes and choose OK. Be sure to write the Machine ID as well as the registration 
somewhere, such as on the inside front cover of your software manual, so that you will 
always have it. As long as the Machine ID number stays the same, the registration 
number will work for future installs. 
 

Synchronizing Data  
 
Once the Mate programs have been installed and registered, the information that has been 
entered into the desktop software (Farm Trac+ or Site Pro) must be added to Trac Mate. 
When using Site Mate, the information collected can be brought into your desktop project 
through the synchronization process as well. During the synchronization process, Site 
Mate log files (.fgp) are synchronized directly from Farm Site Mate to a new layer within 
your main project. (Farm Site must be installed to synchronize with Site Mate) 

Synchronizing between Trac Mate and Farm Trac+ (or Site Pro) 
 
The process of exchanging data between Farm Trac Mate on the CE device or laptop 
(mobile unit) and Farm Trac+ on the desktop is called “synchronizing”. This process 
updates your permanent crop records in Farm Trac+ with those entered in the field, as 
well as the mobile unit with any new items added to the list of fields, equipment, or 
supplies. Any planned jobs that have been created in Farm Trac+ are also updated. Farm 
Trac Mate adds the option of synchronizing more than one project. To synchronize more 
than one project, you will have to complete the synchronization process while within 
each individual project. 
 
In Site Pro, Trac Mate allows the synchronization of more than one client’s information. 
All clients will be synchronized when the process is completed. 

Synchronization Process 
During the synchronization process, differences between the lists kept on the Trac Mate 
program and the desktop are reconciled. (Equipment, Supplies, Fields, etc.) This makes it 
possible to add items in the field and on the desktop without worrying that the items will 
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be duplicated when the two machines are synchronized. When the synchronization 
process begins, you will be given the opportunity to match, or Link, new items from the 
Trac Mate program with those already on the desktop. You can also choose to create a 
new item on the desktop software. This means that it is possible to be adding new 
supplies in the field with Trac Mate while someone else is using Farm Fund$ to record 
purchases of the same supplies. 
 
Before records can be synchronized, each farming action should be marked as finished in 
Trac Mate. Unfinished jobs cannot be synchronized with Farm Trac+ or Site Pro. 

To begin synchronization: 
 

1. Make sure Farm Trac Mate is closed on the mobile device. 
 
2. If using a CE device, make sure it is connected and synchronized with the main 

computer using ActiveSync. If using a Titan RT, insert the usb drive into your 
computer’s usb slot. 

 
3. Select Synchronize Trac Mate from the File menu on your desktop computer. 

There will be several options available within this window. 
 

 
 

a. Synchronization: Select whether you will be synchronizing Trac Mate or 
Site Mate. Note: If using Site Mate while performing a Trac Mate job, 
select Trac Mate. 

 
b. Location: Refers to the location of installation for the Trac Mate program. 

Select the appropriate location from the drop down list. If using a usb 
drive, select the appropriate Local Drive. 

 
c. Options: 
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i. Preview job details before recording: Select this option if you 
want to be able to view or edit the operation before the 
synchronization process is complete. If selected, the Farming Box 
will be displayed, allowing you to view or edit the farming 
operation. 

 

 
 

ii. Upload Field Boundaries: Checking this box allows you to view 
field boundaries while working in Trac Mate when it is used in 
conjunction with Site Mate. 

 
4. The Trac Mate Synchronization screen will show the progress of the sync process. 
 

 
 
5. After the synchronization process if finished, you will get a message that the 

synchronization is complete. 

Linking New Information 
 
The synchronization process allows information that has been added to the mobile unit, 
while in the field, to be linked to existing items on the desktop. 

To Link Information: 
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1. Complete synchronization steps #1-3 as previously discussed. If new items have 
been added to Trac Mate, the Linker window will appear. 

 

 
 

2. Highlight the new item on the left. This will be the item that was added within 
Trac Mate. 

 
3. If the resource selected is a new resource, currently not on the desktop software, 

select the Create button. If the resource matches an item already on the desktop, 
highlight the item on the right side of the window and press the Link button. 

 
4. Select OK and complete the link process for each item that was added to Trac 

Mate. 
 
If new people or equipment were created, you will be prompted to enter the properties for 
each new item. 
 
The properties of new supplies will also be entered during the synchronization process. If 
using Farm Fund$, an account will have to be assigned to new supplies. 
 
Once the synchronization process is complete, the new people, equipment, and supplies 
will be available on the Inputs tab. New fields will also be added to the Farm tab. 
 
When data is synchronized, several things occur: 
 

• All field records (Jobs and Regions) that were maked as Finished with Trac 
Mate, will be loaded into Farm Trac+ or Site Pro. This will result in the 
updating of notations, crop histories, chemical records, and enterprise 
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statements. The field colors and patterns on your map (if using Farm Site) will 
also reflect the farming actions that have been recorded with Trac Mate. 

 
• Any items such as fields, equipment, people, supplies, and crops that have 

been added to the desktop program since the last time that you synchronized 
will be added to the lists in Trac Mate. This process ensures that your Trac 
Mate program is always using an up-to-date list of items for your farm. 

 
• All of the field records that were marked as Finished will be removed from 

Trac Mate. Jobs marked as Incomplete will be left in Trac Mate to be finished 
later. 

 
If using Farm Site as well: 
 

• An updated map that includes all field boundaries will be uploaded to Trac 
Mate IF the Upload Field Boundaries box is checked. 

 
• Job logs (GPS maps) that were created in Trac Mate/Site Mate will be 

imported into Farm Site or Site Pro and placed on new layers. 
 
The process of synchronizing can be done as often as you like, however, remember that 
there are limits to the amount of data that a CE device can hold. There are also risks to 
storing too much data on the CE device. The data on the main memory of the CE unit 
will be lost if the unit loses battery power or is destroyed. It is recommended to 
synchronize the data at least once a week, or even daily. 

Synchronizing between Site Mate and Farm Site (or Site Pro) 
 
Once you have created files using Farm Site Mate, that information may be brought into 
your desktop project through the synchronization process. During the synchronization 
process, Site Mate log files (.fgp) are synchronized directly from Farm Site Mate to a 
new layer within your desktop project. 

To synchronize Site Mate log files: 
 

1. Make sure Site Mate is closed on the mobile unit. 
 

2. If using a CE device, make sure it is connected to your computer and 
synchronized using ActiveSync. If using a Titan RT, make sure you have the usb 
drive with the files on it inserted into your desktop computer. 

 
3. Select Synchronize Trac Mate from the File menu within your desktop program. 

Several options will be available. 
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a. Synchronization: Select whether you will be synchronizing Trac Mate or 
Site Mate. Note: If using Site Mate while performing a Trac Mate job, 
select Trac Mate. 

 
b. Location: Refers to the location of installation for the Site Mate program. 

Select the appropriate location from the drop down list. If using a usb 
drive, select the appropriate Local Drive. 

 
Note: Site Mate files must be saved in the My Documents or TMSM Data/Scouting 
folders to allow the files to be synchronized. 
 

4. Select OK to begin the synchronization process. 
 

5. The GPS Logs window will appear. This window will display all Site Mate log 
files that have been saved in the My Documents or TMSM Data/Scouting folders. 

 
6. Highlight the file(s) to be synchronized. Multiple files may be synchronized at the 

same time by holding down the <Ctrl> or <Shift> key while selecting the desired 
files. 

 
7. Check all appropriate boxes under the Options area. 
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a. Import Paths as Points: Allows Site Mate path files to be imported into 
the desktop project as points. The points will keep the attributes added to 
the path file within Site Mate. 

 
b. Import Boundaries as Lines: Allows Site Mate boundary files to be 

imported as lines. No attributes will be tied to the new ‘Lines Only’ layer. 
 

c. Delete Files: Select this option if you would like the Site Mate files to be 
deleted from the selected synchronization location after importing. 

 
8. Select OK to import the selected file(s). The files will be imported to your 

desktop as a new layer. 

Saving Information and Preventing Data Loss 
 
Information is saved as it is entered and is kept on the mobile device even after the unit is 
turned off. However, if the main batteries go dead and the backup battery is dead, all data 
in all programs on the unit will be lost. (The Titan RT is not susceptible to this) Some 
units also have a “hard reset” option that will remove all programs and data from RAM. 
Refer to your unit’s documentation for details on proper care and maintenance. 
 
If your WindowsTM CE Device has the capability of using a removable storage card 
(Compact Flash or Secure Digital cards), you can protect your data by saving it to the 
storage card. You can also choose to synchronize Trac Mate data directly to a card by 
choosing “CE Card” for the Synchronization Location. Installing the program to a storage 
card is also an option when initially installing the software. If the battery goes dead, the 
program will re-install itself onto the CE device if it was installed on the storage card. 
There is an option in the Mate programs to Save Settings to Card. This will save all 
registration information as well as all settings within the program to the storage card. If 
the battery goes dead, you simply have to select Load Settings from Card. 
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Viewing Data after Synchronization 

Trac Mate 
 
Once the operations have been synchronized, there are several ways that the data that was 
entered in Farm Trac Mate can be viewed in Farm Trac+ or Site Pro. Each job will show 
up under the Job tab as a separate entry. 
 

1. Notations will be recorded for each job. Notation reports can be viewed under 
Field in the Reports menu. You can also right click on a field in the Map tab 
(Farm Site only) and select Notes or Reports. 

 
2. You can view/edit the job information by highlighting it in the Jobs tab and 

selecting Properties. 
 

3. A report may be printed that includes a map (if Site Mate and Farm Site are used) 
by highlighting the job in the Jobs tab and selecting Print. 

 
4. If Site Mate was used with Trac Mate, you can locate the job in the tree and 

double click on it to view the job map on the map tab. 

Site Mate 
 
The synchronization process automatically creates a new layer for each log file that is 
synchronized to the main program. New log files, or Trac Mate jobs that include log files, 
are synchronized to Farm Trac+ or Site Pro. They will  
 

1. If only using Site Mate, the new layer will not be associated with any Client, 
Farm, or Field. You can assign it and also place it in a category by right clicking 
on the layer in the Farm box and selecting Properties. 
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a. You can choose a category, if appropriate, and then press the Select button 
to assign the layer to a Client, Farm, Field, and Crop. 

 
b. The layer will then show in the tree layout in the selected location.  

 
For more information on re-organizing layers and data, refer to the Farm Site manual. 
 

Configuring the Mate 
Programs 
 
Before beginning to use Trac/Site Mate, you will want 
to configure the program to function as you desire. 
These configuration options are available on the Config 
tab. There are four main sections of this tab. Settings, 
Logging, Display, and Advanced. If Trac Mate is 
installed, there will be a Trac Mate option and with 
Guide Mate installed, a Guide Mate option will show as 
well. 
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Settings 
 
The Settings section of the Config tab is where basic 
information is configured. 
 

 

 

Measurement System 
 
The Measurement System allows users to 
select the units of measure to be used in Site 
Mate. Users will be able to display 
measurements in US-English or Metric as well 
as specify if the measurements are for 
agriculture or turf related operations. You can 
also choose to display distances over a certain 
length as miles (km) instead of feet (meters).  
 

Coordinate System 
 
The Coordinate System setting allows users to 
select the coordinate system to be used for 
displaying geographic coordinates in Site Mate. 
The coordinate system does not have to match 
the coordinate system of the GPS receiver. The 
coordinate system that is selected here is for 
display purposes only. Site Mate will always log 
data in the Lat/Long system. 
 

GPS Settings 
 
The GPS Settings screen displays several tabs: Source, Comm, Quality, Offset, 
Simulation, and Output. 
 
The Source tab is where the GPS source will be selected. 
 

• GPS Receiver on COM Port – This option is used when you wish to create a map 
based on data received from the GPS receiver. When this option is selected, you 
will use the Comm tab to enter the settings for your GPS receiver. 
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• GPS Simulation – This option allows 
you to simulate the mapping of a 
boundary or swathing without having a 
GPS receiver attached. This lets you 
experiment with the program to become 
familiar with it without having to 
connect a GPS receiver and be outside. 
When this option is selected, you can use 
the Simulation tab to enter settings for 
the simulation. 

 
• Manual Location Entry – This option is 

used to manually record positions on 
your map without a GPS receiver. If, on 
the map tab, the Manual Coords Tool is 
selected, you can click anywhere on the map and that is where the location will 
be. 

 
The Comm tab allows you to configure Site 
Mate to communicate with your external GPS 
receiver. Port, Baud Rate, Data Bits, Parity, and 
Stop Bits will have to be set to match your GPS 
receiver. The bottom port on most handheld 
devices is Comm 1. If you do not know your 
port settings, you can select Auto Baud and Site 
Mate will search and find a GPS receiver that is 
connected and outputting.  
 
Note: Site Mate needs, at a minimum, the 
NMEA strings GGA and VTG. 
 
 
 
 
The Quality tab allows you to select a minimum GPS quality that Site Mate will use to 
log data. If the quality falls below this setting, Site Mate will no longer log data. 
 

• Minimum GPS Quality allows you to control if differential is required and what 
level.  

 
• Maximum HDOP is another quality indicator that is tied directly to the number of 

satellites being used. Some guidance products, for example, will not guide you 
over a 2.0 HDOP. 

 
• Honor NMEA Checksum simply validates the messages coming through to the 

GPS receiver. 
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Note: If you have a GPS position, but the Site Mate will not log, try relaxing some of the 
quality filters.  
 

                     
 
The Offset tab allows you to compensate for an antenna position that is not centered with 
the vehicle as well as enter antenna height and how far it is from the implement so the 
logging with display correctly on the map. 
 
The Simulation tab is used only when the GPS 
source is selected as GPS Simulation. 
 

• Pattern – Choose the pattern that you 
want to simulate: either Boundary, 
Swathing North-South, or Swathing 
East-West. 

 
• Speed – Choose the speed at which the 

simulated position will move across the 
screen. 

 
• Swath – Choose the swath width of the 

path that you want to simulate.  
 

• Clear Log After Each Pass – Select this option to clear the simulated log after 
each pass so the paths do not overlap. 

 
The Output tab is used to send the NMEA data strings out to a communications port. 
Check the box next to Output NMEA to Comm Port and select the correct Port, Baud 
Rate, Data Bits, Parity, and Stop Bits. 
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Note: This option is rarely used, but can be 
helpful when testing light bars or other 
devices when no GPS receiver is available. It 
can also be used to “pass on” GPS data being 
received. This box should be unchecked if 
output is not needed, as it can tie up a Comm 
port on a handheld device. 
 
You can also choose to Log raw GPS output 
to text file if needed. 
 
 
 
 
 

Errors and Warnings 
 
These options allow the user to select the type of notifications used during the logging 
process. 
 

• Flash Message Line – Site Mate will 
flash a message line at the bottom of 
the screen when GPS data is not 
received. 

 
• Audible Message Beeps – Site Mate 

will beep when GPS data is not 
being received. 

 
• Beep When Logging – Site Mate will 

beep as information is being logged. 
 

• Confirm before closing a boundary – If automatic closing of boundaries is 
selected, this will confirm that the user wants to close the boundary before 
automatically doing so. 

 

Exporting Log Files 
 
These options tell Site Mate how to handle the exporting of the log files when they are 
complete. 
 

• ALWAYS export the log file will export the log file each time the log file is saved 
or closed. 

• NEVER export the log file will never export the log when it is saved or closed. 
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• ASK each time a log is saved will 
prompt the user each time a log is 
saved or closed asking whether or not 
to export the file. 

 
Notes:  If ALWAYS is selected, you will need 
to select a Default Export Type. Arcview 
Shape File (shp), Mapinfo Interchange File 
(mif), or Farm Works GPL File (gpl) 
 
With the version X2 of Farm Works desktop 
program, there is hardly ever a need to export 
the log file, as it can easily be synchronized instead. 
 

Database Templates 
 
This option is only available with Site Mate Scouting or VRA. 
 
Each time that you log data, you may create a database template that is linked to the log 
file. This means that in addition to mapping paths, points, and boundaries, you are able to 
add attribute data. Templates may be created before opening a new log file or during the 
process of creating a new log file. 
 
Note: If using pick lists, you will need to set them up previous to creating a database 
template. 
 
To create a new template: 
 

1. From the Configure tab, open the 
Settings area and select Database 
Templates. 

 
2. A list of previously created templates 

will be displayed. These templates may 
be edited or deleted, if desired. Select 
New to create a new template. 

 
3. When creating a new template, enter a template name. This name should describe 

how the template is to be used. Examples would include: “Weeds” for mapping 
weed areas or “Fields” for mapping field boundaries. 

 
4. The Attributes area will display a list of the items that will be recorded in the 

database.  
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5. Select Add to add a new item to the list, 
then enter a Description. The 
descriptions pertain to individual 
attributes included in the database. 
Examples for a weed layer could be 
Type, Intensity, and Notes. 

 
 
 
 
 
 

6. Select a data Type for each data item being recorded. 
 

a. Data types include Number, Text, Date (automatically enters the date), 
and Sample ID (automatically assigns an ID to each sample logged). 
Additionally, any previously created pick lists will show up as options for 
Type. In the weed example: Type of weed would have a data type selected 
as the name of the pick list created for the different types of weeds, 
Intensity could be either Text or Number, and Notes would be Text. 

 
b. Selecting a Text data type provides an option to select the quantity of 

characters. This value defaults to 40, but can be edited. 
 
Note: If selecting pick list as the data type, the attribute name will be changed to the 
name of the pick list. 
 

7. If a Default Value is entered, the program will use this value each time that a 
point or boundary is logged. This value can be changed when necessary. This 
should be used if most of the data being logged will have the same value. 

 
8. Select Add to create additional attributes to the template. The template may 

include as many different items as you like. You will need to create an attribute 
for each piece of information that you would like to record. For example, if you 
need to identify more than one weed variety within a defined area, an attribute 
will need to be created for each identified weed type. 

 
9. Select OK when finished. 

 
Database Templates may be edited or deleted at any time as long as a job is not in 
progress. 
 
To edit a template, highlight the desired template from the list and make the necessary 
changes. 
 
To delete a template, highlight the unwanted template and select Delete. 
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Pick Lists 
 
This option is only available with Site Mate Scouting or VRA. 
 
To make the process of entering data into Site Mate easier, you can create Pick Lists. 
Pick Lists give the ability to create lists of items that can be selected for mapped areas 
and points. For example, if you will be mapping weed problem areas, a choice list can be 
created that includes each type of weed that you will be scouting. Then, when a weed 
area is mapped, the appropriate weed can simply be selected from a list. 
 
To set up Pick Lists: 
 

1. Select Pick Lists underneath Settings on 
the Config tab.  

 
2. A list of previously created pick lists 

will be displayed. These pick lists may 
be edited or deleted as desired. Select 
New to create a new choice field. 

 
3. When creating a new pick list, you will 

first enter a pick list name. This 
description should describe the type of 
data the choice filed will be used for. An 
example would be “Weeds” where the 
choices will be the different types of 
weeds that you will be scouting. 

 
4. Select New to add a new value to the 

list. Enter the new value and select OK.  
 
 
Note: The new values that you set up here will be the actual names that will be selected 
when scouting. For a “Weeds” choice list, the names of all of the weeds that you will be 
scouting will be added to the list. 
 

5. Repeat the previous step for each value that will be added to the pick list. 
 

6. Check the Editable box if you want to be able to add items to the pick list while 
logging in the field. This is helpful as many times you will not know every item 
that you will be logging. 

 
7. Select OK when all values have been added to the pick list. 

 
You may Edit or Delete a pick list from this area as well. 
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Variable Rate Setup 
 
This option allows users to setup controllers that will be used to complete a VRA job. 
Users will be able to Edit an existing VRT Setup, Add a new one, or Delete an unneeded 
setup. This will only be available with Site Mate VRA. 
 
To create a new VRT Setup: 
 

1. Select Variable Rate Setup from the 
Settings section of the Config tab. 

 
2. Select New. The VRA Controller screen 

will appear. Setup information for the 
controller will be entered on the tabs 
displayed – General, Map, Applicator 
(App), Controller (Ctrl), and Notes. 

 
3. On the General tab, enter a Setup 

Description for the controller setup that 
you are creating. Choose the type of 
controller you are using from the drop 
down list and select the Comm Port to 
which the controller is connected.  

 
Note: You will usually want a separate variable rate setup for each controller that you 
will be using. If one controller will be used with different products or machines and they 
require different settings, you may want to create a separate setup for each one. 
 

4. On the Map tab, enter the Default Rate. 
This is the rate that will be sent to the 
controller if you go outside of the defined 
area on a variable rate prescription map. 
Set this to zero if you do not want it to 
turn on outside of the map.  

 
5. Enter the conversion of map to controller 

units. There are times that the units on 
the prescription map do not match the 
units that the controller needs. If the map 
is in tons and the controller needs 
pounds, you would enter a conversion of 
1 map unit = 2000 controller units. If 
both units are the same, simply enter 1 
map unit = 1 controller unit. 
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6. On the Applicator tab, enter the settings related to the rate controller and the GPS 
receiver 

 
a. Feed Delay – This is the time (in 

seconds) that it takes for the 
implement to respond to a change 
in rate. 

 
b. Following Distance – This is the 

distance (in feet or meters) from 
the GPS receiver to the distribution 
point of the implement. If the 
receiver is behind the boom 
section, for example, enter a 
negative number.  

 
Note: You will still need to enter GPS offsets in 
the GPS Settings screen. This value has no effect 
on those. 
 

c. Swath width – This is the width of the path that will be displayed on the 
screen as you work the field. If you enter this as the actual implement 
width for your equipment, you will see a coverage map displayed on the 
screen as you drive. 

 
7. On the Controller tab, enter the information specific to your controller. See 

Appendix A for more information. 
 

8. The Notes tab can be used for any general notes related to this setup. You may 
want to include notes of settings that you need to make in the controller itself or 
specific cables that will be needed. 

 
9. Select OK to save the setup. It will now be added to the VRT Setup list. 

 
You can also select the Setup button on the map tab once a VRA Job has been started to 
access these settings. 

Advanced VRA Options 
 
This option is only available with Site Mate VRA. This allows a user to configure how 
Site Mate will respond to the variable rate controller. 
 

1. The General tab allows the user to select whether or not they want the status of 
the booms to control the logging on Site Mate. If the “Only log data when boom 
or spreader switch is on” box is checked, the logging will stop when the booms 
are off.  
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2. The Target tab allows you to select 
how you want the prescription map to 
be displayed. You can either use a Set 
Legend that you create, or let Site 
Mate use a calculated legend and you 
specify how many colors you want 
displayed. 

 
3. The Log tab contains settings that will 

change how the coverage map will 
look. You can choose Rate Map 
(points) and set the legend yourself, 
Coverage Map (paths) which will 
display all one color, or Boom 
Sections (polygons) which will show 
when individual boom sections turn on 
and off.  

 
4. The Booms tab allows you to set up the configuration of your boom sections. 

Select the ordering under Type and how many boom sections there are. 
 

a. Next to the boom number, enter the width of that boom in the units 
displayed. 

 
b. Enter the distance from the center of the booms to the GPS receiver if 

there is an offset. 
 

5. Press OK when finished with the Advanced VRA Setup. 
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Logging 

Auto Logging 
 
These settings take effect when Automatic logging is selected. This means that the user 
does not have to press Log for a position to be recorded. 
 

• Recording Interval – Refers to the 
interval in which data is logged in Site 
Mate. Users may enter a distance and/or 
a time interval. Whatever criteria is set 
must be met before Site Mate will log a 
position. If using a combination of time 
and distance, both criteria must be met 
before Site Mate will log any data. 

 
• Auto-close boundaries – This option has 

Site Mate close the boundary and stop 
the logging when you get within the 
specified distance of your starting point 
of the boundary. 

 
• Show Flag/Marker Button – This option will display the flag button on the map 

tab to easily flag objects in a field during a job. 

Sample IDs 
 

• Log Sample IDs (Site Mate Basic only) – If this option is checked, Site Mate will 
assign Sample IDs to each logged point. 
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• Check for Unique IDs – Site Mate will 
verify that an ID will not be used twice 
in the same log file. 

 
 
 

Offset 
 
Site Mate can apply an offset to any position 
being logged. This can be helpful if mapping a 
boundary and you cannot drive directly on top 
of the boundary. You simply enter which 
direction the object is that you want to map 
from the receiver and a distance and Site Mate 
will apply the offset. (if the boundary is left of 
the receiver, use a left offset) 
 
Note: Be sure not to back up when logging an 
offset, as what would have been a right offset 
will be a left offset when going in reverse. 
 

Display 

Current Position 
 
This option allows the user to configure how the 
current position is displayed. The shape can be 
selected, as well as the color and size of the 
icon. The size can be based on feet (meters) or 
pixels. If set to feet, the icon will get smaller as 
you zoom out, where if it is set to pixel, it will 
always appear the same size on the map screen. 
 

Grid 
 
The grid option will display grid lines on the 
map tab so the user has a reference as to 
distances. Under settings, choose the size as well 
as the color you would like the grid to be 
displayed as. 
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Indicators 
 
This option allows you to choose what, if any indicators are shown on the map screen. 
 

• Show Coordinates Line – will display the current GPS coordinates at the bottom 
of the screen. 

 
• Show Speed and GPS Status Line will display the ground speed as well as the 

status of the GPS at the bottom of the map screen. 
 

o GPS and Differential Status will 
display indicators showing 
whether or not you have GPS 
signal as well as Differential. 
When the indicators are black, 
you have signal. 

 
o Number of Satellites and HDOP 

displays how many satellites are 
being used as well as the HDOP 
value. 

Boundary 
 
Users will be able to select whether the actual 
and/or the offset boundary line will be mapped. 
A color for each can also be selected. Only the 
selected option will be displayed on the Map tab 
of Site Mate. The border width can also be 
entered here. If zero is entered, the line will 
change width automatically based on the zoom 
level. If offset is selected and there is no offset 
entered, the actual path will be displayed. 

Path 
 
The actual and/or the offset path line can be 
displayed as well. Once again, only the selected 
option will be displayed on the Map tab of Site 
Mate. The width of the line to be logged will 
also need to be entered. Entering a zero will 
cause the line to change widths based on the 
zoom level. If offset is selected and there is no 
offset entered, the actual path will be displayed. 
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Points 
 
Enter a color and a size for the points that will be 
logged with Site Mate. 
 
 
 
 
 
 
 

Background 
 
Select a color for each background file type, 
Boundaries, paths, and points. The line width 
will apply to polygons as well as lines. Entering 
a zero for the width will cause the line to adjust 
based on zoom level. 
 

Advanced 

Advanced Logging Options 
 

• Allow Suspended Logs – When this 
option is selected, users will be able to 
suspend a log in progress and start a 
new log. This can be helpful when 
logging more than one type of 
information at the same time. For 
example, if you are logging a path and 
want to log a point, you can suspend 
the path and then map the point 
without completely stopping the path 
log. 

• Enter Attributes Before Logging – 
When selected, users will be prompted 
to add attributes to a log file as soon as the log is created. 

• Default Attributes to Previous Log – When selected, the attributes of a new log 
file will default to the same attributes that were used on the previous log. This is 
helpful when a lot of the information being logged will stay the same. 

• Enable Implement Switch – If an implement switch is being used, it must be 
enabled here. (Do not check this box if an implement switch is not connected!) 
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An implement switch can be used to turn the logging on and off automatically. 
Select how the implement switch is connected to Site Mate. 

• Reverse Implement Switch Logic – If logging is backwards to what it should be 
(off when it should be on and vice versa), select this option to reverse the logic. 

Laser Range Finder 
 
Site Mate allows you to connect a Laser 
Range Finder to your computer or CE device. 
A laser range finder is a device that uses a 
laser to log points in the field without actually 
positioning the GPS receiver at the point.  
 
 

Tilt Compensation 
 
Farm Works offers a tilt compensation module 
that corrects the GPS position based on the tilt 
of the machine. The tilt compensation must be 
configured within Site Mate to function 
properly. The module must be connected to 
Site Mate to configure it.  
 

• The receiver height will be set to 
match the antenna height entered in the 
GPS Settings previously. To set this, 
press Reset GPS height in TCM. 

 
• You will then need to tell the terrain compensation module (TCM) where its level 

state is. Park the vehicle so it is level and press Set tractor is level state. 
 

• When finished, choose Save settings in TCM memory. 

Trac Mate 
 
From the Trac Mate option on the Config tab, you can add, edit or delete the Trac Mate 
resources being used. Select each of the items to modify the lists: People, Equipment, 
Supplies, and Other Lists. You will then be able to create New, Edit, or Delete 
unwanted items. 

Guide Mate 

Indicator 
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• Select the Zoom Level by entering a 
Look ahead value. The larger the look 
ahead, the smaller the indicator will 
appear. 

• Indicator size controls the size of the 
circle in the center of the indicator. If it 
is entered in feet, it will change size 
based on the zoom level. If it is entered 
in pixels, it will always appear the same 
size on the screen. 

• Indicator movement controls whether 
the arrow rotates as you turn (Moving) 
or the screen rotates (Stationary). 

 

Lightbar 
 

• If using an External lightbar, you will select the appropriate settings here. You 
can choose which Comm port it is communicating on as well as the Brightness. 
Notice there is an easy way to switch from Day to Night mode to dim the lightbar. 

 
• You can also choose to show or hide the On-Screen lightbar. This will display a 

lightbar on the guidance screen. 
 

• If you press the Settings button, you can adjust the distance between lights, 
choose whether to follow the lights or drive away from them, and whether or not 
to display the lightbar on the Map tab. 

 
 

   

Headlands 
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Guide Mate can display a warning when coming into the headlands. This feature only 
works when you use a headland pattern. Check the box to Display countdown to 
headlands and enter how far from the headlands you want the warning to display. You 
can also choose to have an Audible alert when coming into the headlands. 
 

Micro-Guide 
 
Farm Works offers a Bluetooth enabled Micro-
Guide Lightbar to assist with guidance. If using 
one, check the box to enable it, select the correct 
Comm Port for Bluetooth and select the correct 
baud rate. 
 

Using Farm Trac Mate (without Site Mate) 
 
Once Farm Trac Mate has been installed and registered, you may start entering field 
records. This chapter is designed to give you the basics on how to use Trac Mate for 
entering field records.  
 

Selecting a Project 
 
The first time Trac Mate is opened, you will be prompted to select a project or client. 
However, projects/clients can be changed at any time by selecting the Change Project 
button. 
 
If multiple projects/clients have been 
synchronized with Trac Mate, make sure the 
desired project/client has been selected before 
recording farming operations. 
 
To select/change a project: 
 

1. Select the Trac Mate Job or Unfinished 
Jobs / Workorders button. 

 
2. Select the Change button. The Data 

Folder box will display the location of the project files. Select the correct location 
and then the Project box will display all projects and/or clients that were 
synchronized from Trac+ or Site Pro to Trac Mate. 

 
3. Highlight the desired project/client. 
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4. Select OK. 
 
You can also delete a project or client from Trac Mate by selecting the Delete Project 
button. 

New Job Screen 
 
This screen allows you to select the field, crop, type, and data for a new Trac Mate job. 
 

• Field – The farming operations will be 
performed on the field that is selected 
here. All fields entered on the desktop 
will be available for selection from the 
drop down lists. 

 
• Crop – The current crop enterprise 

that is active in the field. Once the 
field is selected, the corresponding 
crop will be displayed based on what 
was entered on the desktop. This value 
may be changed if needed. 

 
• Type – The Type item describes the farming operation that will be recorded. A 

job cannot be started until a Type has been entered. 
 
Note: There will be an Add/Edit option available for each of the above items. This 
allows new information to be added to Farm Trac Mate. New items can be added and 
items that are already listed may be edited or deleted. This will update to the desktop 
when Trac Mate is synchronized. 
 

• Date – Date that the farming operation took place. This defaults to the current 
date, but can be changed if needed. 

 
• Same Setup as Last Job – Check this box if performing the same operation as 

the last job. This will save time if using the same people, equipment, supplies, etc. 
as the previous operation. 

 
• Use VRA – If Trac Mate has been installed with Farm Site Mate – VRA and you 

want to variable rate a product or create an as-applied map, check this box. 
 

Job Setup Screen 
 
Items that will be used for the Trac Mate Job are selected on this screen. 
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People  
 
Choose the People button to select the person(s) 
that will be used in this job. People that have 
already been entered on the desktop prior to 
synchronization will be displayed in the list. 
Highlight the desired person and select OK. 
 
You can also add, edit, and delete people in 
Trac Mate by selecting the appropriate button. 
These changes will take effect in the desktop 
software the next time Trac Mate is 
synchronized. 

Equipment  
 
Press the Equipment button to select equipment 
being used in the Trac Mate job. Previously 
entered equipment will be available from the 
list. Simply highlight the desired equipment and 
select OK. Equipment must be added to a job 
before supplies can be added. 
 
You can add equipment that has not been added 
to the program as well as edit any equipment 
properties or delete a piece of equipment. When 
adding the equipment, you must enter the 
properties of that piece of equipment. For 
information on setting up equipment properties, 
see the Farm Trac+ manual. 

Supplies  
 
At least one piece of equipment must be added to the job before supplies can be added. 
 
To use a supply in an operation: 
 

1. Highlight the equipment that will be applying the product and then select the 
Supplies button.  

 
2. Open the desired supply type and highlight the name of the supply to be used. All 

supplies that were entered into Farm Trac+ prior to synchronization will be 
available in this window. Press OK to add the supply to the job. 

 



Farm Works Mate X2 Reference Guide 

40 

Note: You may add, edit or delete a supply from this screen.  
 

3. Once the supply has been selected, you 
will be prompted for the Initial Quantity 
and the Expected Rate. When you enter 
the Initial Quantity and Expected Rate, 
the Expected Area of coverage will 
automatically be calculated. 

 
4. The Fill button will later allow you to 

create additional batches using the same 
rate for the next tank mix. 

 
Note: The Initial Quantity and Fill options area not required. They only need to be used if 
you want Trac Mate to track the quantity of each supply that you have left at any time 
during an operation. 
 

5. If selecting a chemical supply, there will 
be a Carrier and a Pests button 
available. 

 
a. Select the Carrier button; 

choose the carrier and the carrier 
rate in the next screen. 

 
b. You can edit the pests that the chemical controls by selecting the Pest 

button and adding new pests to the list. 
 

6. Once a supply has been added to the Job Setup screen, its properties may be 
changed by double clicking the supply name and making the appropriate changes. 

Harvested Crop  
 
If harvesting, select the Harvested Crop button to select the crop enterprise being 
harvested. If the enterprise does not exist, you may add it and set it up at this time. The 
harvested crop icon should be added to any operation that involves harvesting a crop. 
This selection will allow you to enter scale tickets or the total yield for an operation. 
 

 Items can be removed from the Job Setup screen by highlighting the unwanted item 
and selecting the Delete button. 
 
To save the Job Setup information, select OK.  

Application Width 
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A dialog box will appear asking for the Application Width. If not using Site Mate, this 
value may be left blank. 

The Job Tab 
 
Once all of the desired items for a Trac Mate job 
have been selected on the Job Setup window, the 
selected items will be displayed in the Job tab. 
 

• Line 1: Displays the name of the project 
that you are working in and the date of the 
operation.  

 
• Line 2: Displays the field name and the 

start time. 
 

• Line 3: Displays the current enterprise in 
the field and the operation type. 

 
• Line 4: Displays the Region(s) and the 

Region Area. 
 
The large box in the middle displays the items (people, equipment, and supplies) that 
were selected for the operation.  
 
There will be a Field Conditions, Weather, and Notes option available at the bottom of 
the box. By tapping on these items, you will be able to enter the applicable information. 
 

• Field Conditions include growth stage, application method, soil condition, and 
soil type. There will be a pre-set list included for each item, but you may also 
add/edit the lists to suit your own needs. 

 
• Weather Information includes temperature, relative humidity, sky conditions, and 

wind speed, gusts, and direction. 
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• The notes option allows you to add 
additional notations to the operation. The 
standard farming operation notation will 
still automatically be generated. These 
notes can be helpful for noting any 
broken tile, weed problems, or insect 
problems. When Trac Mate is 
synchronized with the desktop, these 
notes will be added to the Notations 
Report. 

 
 
Beneath the job box, you will see several buttons – Go, Layers, Change, and Finish. 
 

 
 

Go – Once selected, this button will change to Stop. If Site Mate is being used along with 
Trac Mate, this button will tell Site Mate to start/stop logging.  
 
Layers – This is only available if you are using Site Mate. This button will display the 
log file currently being created in Site Mate and will allow you to load a background 
layer. This is useful if you wish to display another map such as a soil type or yield map. 
 
Change – Allows you to add or remove people, equipment, and supplies from a job. 
Selecting this button creates a new region for the job. Selecting Change will prompt the 
Change Operation screen to appear and you will be asked for the following information: 

 
Area Since Last Change – area 
covered since you started the operation 
or since you made the last change. 
This becomes the area of the region 
being completed. This will be 
automatically calculated if using Site 
Mate with GPS based off of the area 
covered. 
 
Total Area – sum of all areas 
including the area entered in the Area 
Since Last Change. This includes all 
regions. 
 
Field Size - total acreage of the field. This is the same acreage that is used from 
the Tillable Area in the properties of the field. 
 

Finish – Gives the option to mark a job as Finished or Incomplete. More will be covered 
on finishing a job in a later section. 
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Adding/Removing items from a current job 
 
To modify the items being used in the current job, you must select the Change button to 
end the current region and begin a new one. 
 

1. Once the Change button has been pushed 
and the area has been filled in, highlight 
the supply to remove from the job. 

 
2. Select the Delete button and the Units 

Charged screen will appear. If it is a 
supply, it will show the quantity used 
based off of the rate and the area covered. 
Otherwise it will ask you to fill in the 
charge units for the item being removed. 

 
 
To add a different supply, person, or equipment to a job: 
 

1. If adding a supply, first highlight the equipment that the supply will be used with. 
 

2. Select appropriate category icon: personnel, equipment, supplies, harvest 

 
 

3. Select the item you would like to add from the list. If the item you want is not in 
the list, you can add it by selecting the New button at the bottom of the screen. 

 
4. Select OK to add the item to the job. 

 
5. If adding a supply, you will be prompted to enter the Expected Rate for the supply 

being used. 
 

a. Select the Carrier and Pests, if applicable. 
 

b. To track the amount of the supply at any time, select the Fill button to 
enter the amount of the supply loaded into the equipment.  

 
c. Select OK to save the information for the supply. 

 
6. Select OK to add the item to the job. 

Entering Harvest Data with Scale Tickets 
 
Whenever the Harvested Crops icon is added to an operation, you can enter total yield or 
scale tickets for the current operation. To enter harvest information with scale tickets, 
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simply select the harvested crop icon from the Job tab and enter the scale tickets from the 
operation. 
 

1. Select the Harvested Crop icon  on 
the Job tab once the job has been started 
in Trac Mate. 

 
2. Tap on the Scale Ticket button. 

 
3. To add a new scale ticket, select the 

New button. 
 

4. Enter the Load ID as well as the Gross and Tare weights, Moisture, and FM 
percentages. 

 
5. Select the Crop Setup button to view/edit the density of the harvested crop as 

well as the shrink schedule 
 

  
 

6. Select OK to accept this scale ticket or New to add an additional ticket. 
 

7. Scale tickets may be viewed/edited by selecting the Scale Ticket button and using 
the arrows to scroll to the desired scale ticket. 

 
8. You may delete a scale ticket by selecting the Delete button while viewing the 

unwanted ticket. 

Entering Yield Data without Scale Tickets 
 
Yield data may also be added to Trac Mate using the average yield or total yield for the 
current operation. To enter yield data without scale tickets: 
 

1. Select the Harvested Crop icon  from the Job tab. 
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2. Enter the area harvested. 
 

3. Enter the Average Yield or the Total Yield and the other will be calculated 
automatically based off of the area harvested. 

 
4. Select OK to record the harvest information. 

 

 

Finishing a Job 
 

1. Whether the job is complete or incomplete, select the finish button at the bottom 
of the Job tab. 

 
Finished – tells the program that the operation 
is complete and ready to synchronize to the 
Farm Trac+ project or Site Pro client. You will 
not be able to view this operation until it has 
been synchronized. 
 
Incomplete – Tells the program the operation is 
not complete. This operation will be available as 
an Unfinished Job/Work Order. An incomplete 
job will not synchronize to the main project. 
 
Note: It is recommended that jobs that will be 
completed on a different date or have other jobs 
performed in the meantime be marked as 
finished.  
 

2. When you mark a job as Finished, you 
will be prompted to enter the area since 
last change and/or total field area. 

 
3. You will then be asked to enter the 

charge units for the people, equipment, 
and supplies for the job. 
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The Units Charged screen will display the units charged for the people, equipment and 
supplies, as well as the quantities for each of these items. This information will be linked 
to the information entered previously, but can be edited here as well. 
 
People – typically charged by the hour, this is the total time spent on the job. Trac Mate 
will compute the total hours worked starting when you select the Trac Mate Job or 
Unfinished Job/Workorder button in the Job tab. The time will end when you select the 
Finish button in the Job tab. When an unfinished job is selected, the program will add to 
the number of hours previously logged. 
 
Equipment – If equipment was set up as metered, the starting quantity will already be 
displayed on this screen. You will also be able to view the starting and ending meter 
entries. If you are not using the metered option for this equipment, the total units will 
have to be entered. 
 
Supplies – This screen will display the starting, ending, and total quantities used for each 
supply as well as any amount added throughout the job. These values will already be 
displayed if using based on area covered and quantities entered during fills, but they can 
be edited here as well. 

Unfinished Jobs / Workorders 
 
There are two different ways to get an operation to display under the Unfinished Jobs / 
Workorders button. 
 

1. Planned Jobs – Planned jobs that are created in Farm Trac+ or Site Pro can be 
exported and made available as a Workorder. Planned jobs are exported from the 
Jobs tab on the desktop software by right clicking on the planned job. When the 
Trac Mate synchronization process is completed, the Planned Jobs will be found 
as Work Orders in Trac Mate. This operation can then be completed in Trac Mate. 
Your Farm Trac+ manual has more information on creating plans / workorders. 

 
2. Incomplete Trac Mate Job – When a Trac Mate job has been started and marked 

as Incomplete, the operation is saved to be re-opened at a later date for 
completion. 

Opening an Unfinished Job / Workorder 
 

1. Select the Unfinished Job / Workorder button on the Job tab. 
 

2. Highlight the desired unfinished job / workorder. 
 

3. Select OK. 
 



Farm Works Mate X2 Reference Guide 

47 

Note: If you do not see the desired workorder / unfinished job, make sure the correct 
project is selected by tapping on the Change Project button. See the Selecting a Project 
section of this manual for detailed steps on changing projects. 
 

4. Once the Unfinished Job or Workorder has been opened, the Job tab will display 
the operation. The selected job may be edited. Refer to the Job Tab Section of this 
manual for detailed instructions. 

 

Using Trac Mate (with Site Mate) 
 
Using Site Mate in conjunction with Trac Mate allows you to map coverage and, if VRA 
is installed, send rates to a variable rate application controller via a map. Using Site Mate 
requires the use of a GPS receiver for positions. 
 
To create coverage maps while performing a Trac Mate job: 
 

1. Follow all of the steps of using Trac 
Mate without Site Mate through the Job 
Setup Screen. 

 
2. Be sure to enter the actual Application 

Width of your implement when 
prompted. 

 
3. Once the job has been started, you can 

go to the Map tab in Site Mate and the 
field boundary for the selected field 
should be displayed. If you are located 
within the field, have a GPS signal, and 
the GPS unit is connected properly, the 
position indicator should show where 
you are located inside the field 
boundary. 

 
4. The Go button on the Map tab performs 

the same function as the Go button on 
the Job tab. Press one of these buttons 
when you want logging to begin. 

 
5. Site Mate will now log coverage wherever you go in the field until you press the 

Stop button. If an implement switch is connected, coverage will stop when the 
implement is up or off. See the Advanced Logging Options section of this manual 
for settings on connecting an implement switch. 
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6. Trac Mate will then use the area calculated by the coverage map while recording 
the job. The area will show on the bottom of the Map tab as well as in the Region 
Area on the Job tab. 

 
7. This area will be entered into the correct locations when changing regions and 

completing fields. You will, as before, be able to modify the area value. All inputs 
that are based on area (charge units and supply rates) will be computed off of this 
number as well. 

 
8. Finish a job (finished or incomplete) just as you would if not using Site Mate. 

 

Using Site Mate 
Tools and Indicators 
There are several tools within Farm Site Mate that make data entry and data monitoring 
easier. The following tools are available from the Tool button at the left of the Map tab or 
by selecting the Tools menu within Site Mate. 
 

• Pointer Tool: Used for selecting lines or objects. Users may also use the pointer 
tool to right click on a line or object and view the right click menu. 

• Manual Coordinates Tool: Used when the GPS Source has been set to Manual 
Location Entry. 

• Navigation Tool: This option is only available with Farm Site Mate-Scouting and 
VRA. The Navigation Tool is used to navigate to a selected point. See the section 
on Scouting Features for more information. 

• Measure Tool: Used to measure the length of a line. Simply select this tool from 
the Tool button and click and drag the line to be measured. The length will be 
displayed to the left. If you need to measure more than one line segment, select 
the Sum box and click at every line segment. 

• Zoom Tool: Used to zoom (in or out) on a map. Once selected, a left click will 
zoom in on the selected area and a right click will zoom out. You can also click 
and drag around an area to zoom in to it. 

• Align GPS: This option is used to shift a map to compensate for GPS drift. If a 
background map appears to be shifted, you can go to a known point and shift it to 
where it is suppose to be. You cannot Align a map that is being logged to. 

 
The Tools menu also allows users access to the zoom options. These options are also 
available as buttons at the bottom of the Map tab. 
 

• Zoom In:  Zooms in on the current map by 2x each time selected. 

• Zoom Out:  Zooms out from the current map by 2x each time selected. 
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• Zoom All:  Zooms in or out from the map so that all information currently 
displayed is displayed on the screen. 

 
Site Mate also provides several indicators to make data collection easier while you are in 
the field. 

 
• Speed: Site mate will display your current speed at the bottom right corner of the 

screen 
 

• Compass: The current heading will also be displayed at the bottom of the screen. 
 

• GPS and Differential Indicators: If the option to Show GPS and Differential 
Indicators was selected on the Config tab, these indicators will be activated when 
receiving GPS and/or Differential. If the option to Show Number of Satellites and 
HDOP Indicators was selected, the appropriate values will be displayed at the 
bottom of the screen. 

Job Tab 
 
The Job tab of Site Mate is where you will decide the type of operation you are 
completing. 
 

• Trac Mate Job: This button is only available if Trac Mate is installed. Select this 
option to begin a Trac Mate job that allows you to select the people, equipment, 
and/or supplies to be used in a farming operation. See the Trac Mate section of 
this manual for more information. 

 
• Scouting Job: Select this option to complete a typical Site Mate job. Users will 

be able to create a new or load an existing .fgp or .gpl file as well as load 
background maps. This is used for any basic mapping functions. 

 
• Sensor Job: This option is only available if Site Mate-VRA is installed. Select 

this option to use a variable rate controller along with Site Mate to create a 
coverage and as-applied map. This option will not allow you to load a variable 
rate prescription map. 

 
• VRA Job: This option is only available if Site Mate-VRA is installed. Select this 

option to use a Site Mate to load a variable rate prescription map and send the 
rates to a controller. 
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• Unfinished Jobs / Workorders: This option is only available if Trac Mate is 
installed. Select this option to complete any unfinished Trac Mate jobs or 
exported planned jobs (work orders). 

Map Tab 
 
The Map tab allows users to view the map as it 
is being created.  
 
Once an application log has been loaded or 
created, the Map tab will contain several pieces 
of information that are helpful while logging 
data. 
 
At the side of the screen there are three buttons. 
 
The first button is the Tool button. This button 
supplies a short cut for selecting tools within 
Site Mate. Tools may also be selected from the 
Tools menu. Tools available for selection 
include Pointer, Manual Coordinates, 
Navigation, Zoom, Measurement, and Align GPS.  
 

    
 

The second button is the Log Type button and refers to the type of data that will be 
logged. Users will be able to select Path, Points, or Boundary. Select the desired type 
before beginning the job. 
 
The third button is the Go button. The Go button tells Site Mate when to begin logging 
data. Once selected, Go will change to Stop. Select Stop when the logging is complete. 
 
Once Go is selected, an additional button will appear – either Pause or Log. If you are 
manually logging data, a Log button will appear. Each time that you want Site Mate to 
log data, select the Log button. If you are logging data automatically, Pause will appear. 
The Pause button is used to stop logging data temporarily. Once selected, Pause will 
change to Resume. Select Resume to begin logging again. When Resume is selected, 
your current position will connect the position where Pause was originally selected. 
Pause is usedful when there is an obstruction in your direct path that you need to travel 
around, but do not wish to leave a gap in the line or boundary. 
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The Offset indicator is also located at the left side of the 
screen. This will display the current offset, if 
applicable, as well as the direction of the offset. Users 
may tap on this to change the current offset. 
 

  
 
Across the bottom of the Map tab are useful viewing 
tools – zoom and scrolling tools. The four arrows at the 
bottom right allow you to move the screen in the 
indicated direction. 

Data Tab 
 
The Data tab displays information related to the current GPS signal. Users can select 
different NMEA strings that they would like to view information on in this tab. Note: The 
GPS receiver must be outputting the selected string for data to be viewed. 

Scouting Job 
 
The Scouting Job button on the Job tab allows users to start a new log file and/or load a 
background map. To open an existing log file, select the Open button next to the Scouting 
button and browse for the log file. 
 
To create a New Log File: 
 

1. Select New Scouting Job from the Job tab. 
 

2. Enter the name of the new file. 
 

3. Select the location for the file to be saved from the Folder window. You need to 
save the file in either the TMSMData/Scouting folder or in My Documents for 
Farm Site to be able to synchronize the job. 

 
4. Select OK to accept the new file name and location. If using Site Mate Scouting 

or VRA, the Template Screen will appear, otherwise skip the next 2 steps. 
 

5. The Template screen allows users to add a template to the log file. Templates 
allow users to link attributes to a log file. Select the desired template from the list 
or create a new template. For more information on creating templates, see the 
Configuration Section of this manual. If no attributes are desired, select “No 
Attributes”. 
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6. Select OK to accept the template. You will be taken to the Map tab and will be 
ready to begin logging information.  

Loading Background Files 
 
Site Mate allows you to load an unlimited amount of previously created maps behind the 
current log file. This is called a background map.  
 

1. Select the Layers button from the bottom of the Map tab. 
 

2. Browse to the location of the saved background and highlight the desired file. 
Backgrounds can be .shp (shape files), .bmp (image), or .smb (site mate batch). 

 
3. Select OK and you will be taken to the Background screen where the selected 

background will be listed.  
 

4. To open more background layers, select Open from the drop down list and repeat 
the last 2 steps. 

 
5. Once a background layer is loaded, there are more options in the drop down list. 

Highlight the background layer that you want to change the options for. 
 

a. Legend: Select this option if you would like to view a legend for the 
selected background. Users will be able to select the data item they wish to 
create the legend for as well as the color for each range. 

 
b. Label: Select this option to display a label for the selected background. 

Users will be able to select which attribute(s) will be displayed in the label 
and whether the label will be transparent or opaque.  

 
c. Close: Select this option to remove the selected background from the 

display. 
 

d. Close All: Select this option to remove all backgrounds from the display. 
 

6. Select OK to accept the listed background maps. You will be returned to the map 
screen. 

 
Once the log file and backgrounds have been loaded, you will need to decide what mode 
of logging you will be using: manual or automatic. 

Manual Logging 
 
Manual logging is typically used for logging sample points and allows users to tell Site 
Mate when and where to log a point. 
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To manually log points once a scouting job is open: 
 

1. Select Manual from the Log menu at the bottom of the Map tab. 
 

2. Select the desired log type from the button at the side of the screen (Boundary, 
path, or point). 

 
3. Select Go and the Log button will appear. 

 
4. Travel to the location of your first point and select Log. The attributes window 

will appear if you selected a template when starting the job. 
 

5. Enter the attributes, if applicable and select OK to accept the logged point. 
 

6. Log all additional points and select Stop when finished. 
 
Boundaries and paths may be logged manually as well. To do this, you will select Log at 
the starting point of the line or boundary and then select Log at each direction change 
(corner) of the field. Each time that Log is selected (after the initial time) a straight line 
will be drawn between the previously logged point and new logged point. 

Automatic Logging 
 
Automatic logging is most commonly used for logging boundaries and paths. It will 
create the map as you are traveling through the field. 
 
To automatically log data once a scouting job is open: 
 

1. Select Automatic from the Log menu at the bottom of the Map tab. 
 

2. Select the desired log type from the button at the side of the screen (Boundary, 
path, or point). 

 
3. Select Go to begin logging data. The Stop and Pause buttons will appear. 

 
4. Site Mate will begin logging data according to the recording intervals set in the 

Config tab. 
 

5. Select Pause to stop the logging process temporarily. 
 

6. Select Stop when the scouting job is complete. 
 
Once the log file is complete, you are ready to close the file and synchronize it to your 
main computer. To close a file, go to the Job tab and select the Close Job button. 
Depending on your settings in the config tab, you will be asked if you would like to 
export the log file and what type of export you would like to create.  
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Note: You do not need to export the log file if you plan to synchronize Site Mate using 
the Synchronize Trac Mate option within Trac+ or SitePro. 

Other Site Mate Basic Features 

Grid Sampling 
 
Site Mate makes grid sampling easier by allowing users to create the grids in the field. To 
create a sampling grid: 
 

1. Either load the boundary of the field to be gridded as a background map or log the 
boundary to create the boundary map. 

 
2. Select the Pointer Tool. 

 
3. If you have a laptop computer, right-click on the boundary. If you have a 

Windows CE device, tap on the boundary. 
 

4. Select Grid Area from the pop-up menu.  
 

5. In the Create Sampling Grid window, 
enter the size, shape, and pattern for the 
grid. 

 
6. Select the OK button to return to the map.  

 
7. Click/tap on the starting corner of the 

field, then drag the cursor along the 
boundary in the direction that the grid 
points are to be arranged.  

 
Note: The line that is created here will be used to create the alignment of the sampling 
grid. 
 

8. When you release the mouse (or lift the stylus), the field will be 
gridded.  

 
9. Buttons on the left of the map may be used to modify the grid. 

Setup allows you to modify the size and pattern options previously 
set. Rotate allows you to click and drag again to get a different 
angle of grid squares. Move allows you to drag the entire grid 
around on the map to obtain the best alignment. 

 
10. Press the OK button to accept the current grid alignment. Pressing  

Cancel at any time will abort the gridding process. 
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11. Options will be given to create Points, 

Lines, and/or Polygons in each grid cell. 
Check the appropriate boxes and select 
whether you want the gridded data saved 
as an ArcView Shape file or Map Info 
Interchange file (Shape is the most 
common.) Each object type will be 
created on a separate layer and saved. 

 
Note: Grid points will be circular, so they can 
easily be distinguished from logged points 
(which are squares). 

Manual Location Entry 
 
The Manual Location feature is useful for creating maps when you cannot physically map 
the location with a GPS receiver. 
 

1. When you are ready to map a location 
manually, select GPS settings from the 
File menu or select the GPS settings 
option in the Settings area of the Config 
tab. 

 
2. Change the GPS Source to Manual 

Location Entry.  
 

3. Select the type of data that you wish to log manually (boundary, path, or point). 
 

4. Select the Manual Coordinates Tool from the tool button.  
 

5. Select the Go button to start logging. 
 

6. Tap or click at the position where you wish to log. If you are logging a point, it 
will be displayed on the screen. If you are logging a boundary or a path, they will 
be drawn as you click each corner.  

 
Note: Manual Location Entry uses the same logging intervals as if using a GPS receiver. 
 

7. Select the Stop button to finish mapping the feature. Close and/or export the log 
file as normal. 

 
You can also enter a known coordinate for a manually located point. Log the point, then 
click/tap on the Tools menu and select Enter Coordinates. Enter the coordinates for the 
logged point and select OK. 
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Other Site Mate Scouting Features 

Navigate to Point 
 
Site Mate Scouting (and VRA) adds the ability to navigate to a known point. This is very 
useful when collecting soil samples. Being able to navigate back to a known point allows 
users to navigate to the sampling points created by the grid sampling process of Site 
Mate. 
 

1. Use the Zoom Tools to view the area that you want to navigate to. 
 

2. Select the Navigation Tool from the Tool button on the left.  

 
3. With this tool selected, you may navigate to any point by 

clicking/tapping on the map at that location. A bulls-eye will 
appear at the selected location/point.  

 
4. You can also click/tap on a point already on the map and select Navigate To 

Point. 
 

5. A navigation dial will appear on the screen. The vertical line at the 
top of the dial represents the direction that you are traveling. The 
moving arrow represents the direction that you need to go to reach 
the target. The distance to the target point will be displayed below 
the dial.  

 
6. To see a larger view of the navigation dial, click on it in the bottom left side of the 

screen and select Swap Navigation and Map. To return to the map, click on the 
larger navigation dial and select it again. 

 
7. Click on the “x” above the navigation dial to close navigation. 

Performing a New Sensor Job 
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With Site Mate VRA, you can log what a variable rate controller is doing and create an 
“as-applied map”. If you do not have a variable rate map that you want to control by, but 
want to log the applied rates, use the New Sensor Job option. 
 
To start a New Sensor Job: 
 

1. Verify the Variable Rate Setup information is correct for the controller you are 
using as well as the Advanced VRA Options. See the Settings section of this 
manual for more information on the Variable Rate Setup. 

 
2. Select New Sensor Job from the job tab, or if using Trac Mate, just start a new 

Trac Mate Job and check the box beside Use VRA. 
 

3. If using Trac Mate, proceed though the Job Setup and Application Width screens 
as explained in previous sections and it will then prompt you for Variable Rate 
Layers. 

 
a. Check the Log without Control option and the Rx Map box will be grayed 

out. The Application Log file will be filled in automatically based on the 
field, crop, job type, and data. 

 
b. Select OK and the job will be opened. 

 
4. If you are not using Trac Mate, when you select New Sensor Job, it 

will prompt you for a file name to log to. Enter the file name and select 
OK to open the job. 

 
5. If you are not using Trac Mate, it will prompt you asking for a 

template to use. If you want to use a template, select or create one here 
or select <No Attributes> if you do not want to use a template. For 
information on creating templates, see the appropriate section of this 
manual. 

 
6. On the map tab, on the left side of the screen, you will see a Setup button, a Go 

button and two boxes – Target and Applied. Select the Setup button and make 
sure that the correct controller is selected for this job. You may also enter a new 
controller setup or edit an existing one at this time. 

 
7. Select Go to begin the sensor job. Once the job is started, the Target box will 

display a -1 since you are not controlling the rate from a map. The Applied box 
will now display the rate being applied. You will also notice the booms icon will 
now be highlighted.  

 
8. Select Stop when the job is complete. 
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9. If using Trac Mate, select Finish from the Job tab and complete the job as 
explained earlier in this manual. 

 
10. If you are not using Trac Mate, you may want to export the application log by 

selecting File > Export Log. 
 

11. From the Job tab, select Close Job. 

Performing a VRA Job 
 
If you have an Rx map that you want to use to send a rate to a variable rate controller, 
you will use the VRA Job button or, if using Trac Mate, just start a new Trac Mate Job. 
 
To start a VRA Job: 
 

1. Verify the Variable Rate Setup information is correct for the controller you are 
using as well as the Advanced VRA Options. See the Settings section of this 
manual for more information on the Variable Rate Setup 

 
2. Select VRA Job from the Job tab. If 

using Trac Mate, start a new Trac Mate 
Job and check Use VRA. 

 
 

a. If using Trac Mate, proceed 
through the Job Setup and 
Application Width screens as 
explained in previous sections 
and it will then prompt you for 
Variable Rate Layers. 

 
i. Make sure the Log without Control option is unchecked and click 

the down arrow beside the Rx Map box to select Open. Browse for 
your Rx Map. 

 
b. If performing a VRA Job without using Trac Mate, the program will 

prompt you for your prescription map file. It will then ask you information 
about the Shape File that you are loading. 

 
Note: Rx Maps must be in shape files which contain 3 files altogether. (.shp, .shx, .dbf) 

 
3. Select the Data item contained in the 

shape file that you will be controlling. If 
the Coordinate System used to create the 
Variable Rate map is different than the 
one shown, select the appropriate one 



Farm Works Mate X2 Reference Guide 

59 

and enter the Datum and Zone, if applicable. (Most programs use Lat/Long, WGS 
1984) 

 
4. Select OK to return to the Variable Rate Layers screen. 

 
 
5. The Application Log file name will automatically be created. You can select 

Open to use an existing log, if needed. 
 
6. Select OK to load the Rx map, application map, and any other background files 

that were selected. Select the Map tab to view the Rx map and you are ready to 
being your variable rate application. 

 
 
7. On the map tab, on the left side of the screen, you will see a Setup button, a Go 

button and two boxes – Target and Applied. Select the Setup button and make 
sure that the correct controller is selected for this job. You may also enter a new 
controller setup or edit an existing one at this time. 

 
8. Select Go to begin the VRA job. The Rx box will display the application rate 

assigned to the current area of the Rx map. The As Applied box will display the 
actual rate being applied. You will also notice the booms icon will now be 
highlighted. 

 
9. Select Stop when the job is complete 

 
10. If using Trac Mate, select Finish from the Job tab and complete the job as 

explained earlier in this manual. 
 

11. If you are not using Trac Mate, you may want to export the application log by 
selecting File > Export Log. 

 
12. From the Job tab, select Close Job. 

 

Using Guide Mate 
 
There may be times when you want guidance, but do not want to start a complete Trac 
Mate job. You can start a Guide Mate job by itself or after beginning a Trac Mate job. 
 

1. If using Trac Mate while performing guidance, start the Trac Mate job entirely. 
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2. From the Guide Mate tab, select the 
Swath Pattern that you would like to use. 
(See Swath Patterns in this manual for 
more information.) Also, enter the 
Swath Width. This is the width that you 
want to perform guidance by. If using 
Trac Mate, it will default to your 
implement width. 

 
3. Press the Start Guidance button.  

 
4. Depending on which swath you chose, 

press the button to begin your first swath 
and perform your guidance pattern. See 
Swath Patterns for more information on 
driving each pattern type.  

 
5. Depending on your settings, you will use the on-screen lightbar to steer towards 

or away from the lights. Also use the steering needle to stay on the current swath. 
 

6. The guidance screen will show how far off of the swath and in which direction 
you are. The upper right hand corner will show your swath number as well as the 
coverage area. The right hand side of the screen also shows Target and Applied 
rate if using VRA. 

 
a. If you are using VRA or are tied to an implement switch, the guidance 

arrow will turn red when logging is off and green when logging is turned 
on. 

 
7. You can click on the Map tab to view a coverage map of everything you have 

done. You will also notice a lightbar on top of the map tab as well, so you still 
have guidance even when looking at the map. 

 
a. If using Trac Mate and Site Mate, the field boundary will show on the map 

tab showing your location as well as a red line showing which swath you 
are on. 

 
b. The Flag button is located in the 

upper right hand corner of the 
map tab and places a red point on 
the map. This can be helpful to 
map rocks, blowouts, trouble 
areas, etc. These maps can later 
be imported into Farm Site to 
view. 
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8. The Options button is located on the Guide Mate screen. 
 

a. Reset A-B: Allows users to clear current A-B guidance points and re-set 
new A-B points without closing the current job. After A-B points are 
cleared, return to swath guidance screen and set new A-B points for 
continued guidance. 

 
b. Recal A-B: Allows user to adjust the A-B line reference and all successive 

swaths to this adjusted point. User must determine the precise corrected 
position of the current swath line and position the machine to that point. 
Then press “Recal A-B” then “Continue” to adjust the A-B line reference. 

 
c. Save Guidance: Allows user to save the guidance pattern for use at a later 

time. This can be helpful if wanting to run the same swath for different 
operations within a field. 

 
d. Close Guidance: Closes the job. Guidance pattern will not automatically 

be saved, once closed any unsaved patterns will be lost. If using Trac 
Mate, this option will not close the Job. It will allow you to close the 
current guidance pattern and begin another without starting a new Trac 
Mate job. 

 
e. Mark/Return: After the “Mark/Return” button is pressed, GM will 

display distance back to the marked point, as well as show a line on the 
GM guidance screen to assist with returning to where the original point 
was marked. Press the “Mark/Return” button a second time to clear the 
“Mark/Return” mode. 

 
9. If you are not using Trac Mate, you may want to export the coverage map. Go to 

File > Export Log. 
 

10. Choose which type of file you want to export the map as. The most common 
choice is an Arcview Shape File (shp).  

 
a. You will then need to choose which layers you want to export. (Coverage 

is logged as paths and flags are logged as points.  
 

b. When not using Trac Mate, Guide Mate will name the files according to 
the date created. 
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11. When finished with the guidance pattern, you can either go to the Options button 
on the Guide Mate tab and select Close Guidance or choose Close Job from the 
Job tab if not using Trac Mate. 

 
Swath Patterns: 
 

• Straight AB: Guidance for straight back and forth swathing based on the first 
pass (two button presses required on first pass, no swath to swath button presses 
after the first pass). Press the “Set A” button to begin Swath #1. Continue to drive 
to the end of swath #1 then press “Set B”. Swath #2 will be assigned according to 
the direction turned after the “Set B” button is pressed. All consecutive swaths 
will be based on the original A-B points. 

 
• Contour Fixed: Guidance for curved swath patterns based from the first pass 

(two button presses required on first pass, no swath to swath button presses after 
the first pass). Press the “Set A” button to begin Swath #1. Continue to drive the 



Farm Works Mate X2 Reference Guide 

63 

contoured swath and press “Set B” at the end of swath #1. All consecutive swaths 
will be based on the contour pattern of the first pass. 

 
• Contour 0 Button: Guidance for curved swath patterns based from the last pass 

driven (two button presses required on the first pass, no swath to swath button 
presses after the first pass). Press the “Set A” button to begin Swath #1. Continue 
to drive the contoured swath and press “Set B” at the end of swath #1. All 
consecutive swaths will be based on the last pass driven. 

 
• Contour 1 Button: Guidance for cured swath patterns based from the last pass 

driven (two button presses required on the first pass). Press the “Set A” button to 
begin Swath #1. Continue to drive the contoured swath and press “Set B” at the 
end of swath #1. Swath #2 will be based on the path driven in Swath #1. At the 
end of Swath #2, press the “Set 2B” button. Swath #3 will be based on the path 
driven in Swath #2. Continue these steps for each consecutive swath. 
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• Contour 2 Button: Guidance for cured swath patterns based from the last pass 

driven (two button presses required on each pass). Press the “Set A” button to 
begin Swath #1. Continue to drive the contoured swath and press “Set B” at the 
end of swath #1. Press “Set 2A” at the beginning of Swath #2. At the end of 
Swath #2 press the “Set 2B” button. Swath #3 will be based on the path driven in 
Swath #2. Continue these steps for each consecutive swath. 

 
• C Clamp: Straight pattern swathing with a double headland area on two opposite 

sides of the field. Enter filed in direction of double headland. Press “Set CClamp 
1” and drive to the end of the 1st headland pass and press  
Set CClamp 2”. Turn back towards the next headland pass and Guide Mate will 
give guidance based on the 1st pass. Press “End Pass 2” at the end of the 1st double 
headland. Then turn back towards the direction in which A-B guidance is desired. 
Swath #1 starts after “Set A” is pressed. Continue to the end of Swath #1 and 
press “Set B” (guidance through the field will be based on the original A-B 
points). Turn towards the next headland area and press “Set CClamp 3”. Continue 
to drive to the end of the headland pass and press “Set CClamp 4”. Turn back 
towards the 2nd pass for the double headlands and Guide Mate will provide 
guidance down this pass. At the end of the double headland area press “End Pass 
2”. Then turn towards Swath #2 and Guide Mate will provide guidance based on 
the original A-B points. GM will give a “distance to headland” countdown when 
approaching or leaving the headland areas. 
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• Headland Separate: Guidance based on straight A-B swathing with a headland 

area around the boundary of the field (the A-B points can be marked either within 
our outside of the headland area). Press “Begin Boundary” to start the headland 
perimeter. Continue to drie around the perimeter of the field (GM will 
automatically end the boundary once its position is within one boom width from 
the beginning boundary point. Press the “Set A” and “Set B” buttons to mark the 
A-B line to provide guidance for consecutive swaths through the field. GM will 
give a “distance to headland” countdown when approaching or leaving the 
headlands areas. 

 
• Headlands Combined: Guidance based on straight A-B swathing with a 

headland area around the boundary of the field (the A-B points are marked within 
the headlands area). Swath #1 (and beginning boundary) begins after “Set A” is 
pressed. Continue to drive to the end of Swath #1 then press “Set B”. Then 
continue to drive the boundary of the field (GM will automatically record the path 
that is driven for the headland area). Press “End Boundary” at the point when the 
headland boundary is complete or GM will automatically end the boundary once 
its position is within one boom width from the beginning “Set A” point. Guidance 
for consecutive swaths will be based on the original A-B points that were set. GM 
will give a “distance to headland” countdown when approaching or leaving the 
headland areas. 
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• Headlands*2 Separate: Guidance based on straight A-B swathing with a double 

headland area around the boundary of the field (the A-B points can be marked 
either within or outside of the headland area). Press “Begin Boundary” to start the 
headland perimeter. Continue to drive around the perimeter of the field (GM will 
automatically record the path that is driven for the headland area). Press “End 
boundary” at the point when the headland boundary is complete or GM will 
automatically end the boundary once its position is within one boom width from 
the beginning boundary point. GM will then provide guidance for the 2nd 
headland boundary. Continue to drive the boundary and press “End Pass 2” for 
ending the 2nd headland pass or GM will automatically “End Pass 2” once its 
position is within one boom width from the beginning of the 2nd boundary. Press 
the “Set A” and “Set B” buttons to mark the A-B line. Guidance for consecutive 
swaths will be based on the original A-B points. GM will give a “distance to 
headland” countdown when approaching or leaving the headland area. 

 
• Headlands*2 Combined: Guidance based on straight A-B swathing with a 

double headland area around the boundary of the field (The A-B points are 
marked within the 1st headlands area). Swath #1 (and beginning boundary) begins 
after “Set A” is pressed. Continue to drive to the end of Swath #1 then press “Set 
B”. Then continue to drive the boundary of the field (GM will automatically 
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record the path that is driven for the headland area). Press “End Boundary” at the 
point where the headland boundary is complete or GM will automatically end the 
boundary once its position is within one boom width from the beginning “Set A” 
point. GM will give guidance for the 2nd headland boundary. Continue to drive the 
2nd boundary and press “End Pass 2” at the end of the 2nd headland area or GM 
will automatically “End Pass 2” once its position is within one boom width from 
the beginning of the 2nd boundary. Guidance for consecutive swaths will be based 
on the original A-B points that were set. GM will give a “distance to headland” 
countdown when approaching or leaving the headlands areas. 

 
• Headlands with Contour: Guidance is based on 0 button contour swathing with 

a double headland area around the boundary of the field (the A-B points can be 
marked either within or outside the headlands area). Press the “Begin Boundary” 
to start the headland perimeter. Continue to drive around the perimeter of the field 
(Guidemate will automatically record the path that is driven for the headland 
area). Press “End Boundary” when the first boundary pass is complete (GM will 
automatically “End Boundary” if its position is within one boom width from the 
“Begin Boundary” point). Guidance for curved swath patterns based from the last 
pass driven (two button presses required on the first pass, no swath to swath 
button presses after the first pass). Press the “Set A” button to begin Swath #1. 
Continue to drive the contoured swath and press “Set B” at the end of swath #1. 
All consecutive swaths will be based on the last pass driven.  

o There is an option to set another B point, when in the guidance mode. This 
option only needs to be used IF STOPPING SHORT of the headland 
boundary. If driving to the outside of the headland boundary, the guidance 
system will advance automatically. 

o Enable Snap: The enable snap option on the screen is a feature only 
found in the Headlands with contour and Headlands2 with contour. The 
enable snap button MUST be depressed before any guidance will be 
provided for the pass to pass. When the headlands are completed, press the 
Enable snap button. 
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• Headlands*2 with Contour: Guidance is based on 0 button contour swathing 

with a double headland area around the boundary of the field (the A-B points can 
be marked either within or outside the headlands area). Press the “Begin 
Boundary” to start the headland perimeter of the field. Continue to drive around 
the perimeter of the field (Guidemate will automatically record the path that is 
driven for the headland area). The A-B points can be done as the perimeter is 
being established. Guidance for the established A-B line will be used until the 
operator clears that line. There can be multiple lines established in a field. Clear 
the old line by pressing anywhere on the screen, while in guidance. Select the 
option “Reset A-B”. Depress the “Return to Guidance” button and the user can set 
a new A and B point. This option allows the operator flexibility in fields that have 
many erratic shapes. 

 
NOTE: The cleared A-B line can NOT be brought back; new A-B reference 
points must be set in order for guidance to continue 
 
Upon completion of the second headland, press the End Pass 2 button in order to 
close the second pass. Depending on where the A/B line was established, the 
Enable Snap option will need to be depressed to obtain the pass to pass guidance. 
 
There is an option to set another B point when in the guidance mode. This option 
only needs to be used IF STOPPING SHORT of the headland boundary. If 
driving to the outside of the headland boundary, the guidance system will advance 
automatically. 

o Enable Snap: The enable snap option on the screen is a feature only 
found in the Headlands with contour and Headlands2 with contour. The 
enable snap button MUST be depressed before any guidance will be 
provided for the pass to pass. When the headlands are completed, press the 
Enable snap button. 
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• Spiral: Guidance based on an outside boundary that continues to work towards 

the center of a field. Swath #1 begins after “Begin Boundary” is pressed. 
Continue to drive around the boundary of the field (GM will automatically record 
the path driven for the boundary area). Press “End Boundary” when the first 
boundary pass is complete (GM will automatically “End Boundary” if its position 
is within one boom width from the “Begin Boundary” point). Guidance for Swath 
2 will be one swath width to the inside of the original boundary. “Swath +” and 
“Swath –“ buttons will be present after the boundary has been closed. If “Swath 
+” is pressed guidance will be given to the next swath towards the inside of the 
field. If “Swath –“ is pressed guidance will be given to the next swath towards the 
outside of the field. When at the end of Swath #2, user must press “Swath +” in 
order to initiate guidance for Swath #3, etc. 

 
• One Step: Guidance for straight back and forth swathing, with guidance on the 

initial pass. While moving in the direction of the reference swath, press the “Set 
A” button. This sets the Start mark to the current position and the End mark ahead 
by four swath widths in the direction of the present Course over Ground. 
Guidance and offset indicators are shown immediately. Continue driving the 
reference swath. If offset errors are showing, press the “Set B” button to reset the 
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End Mark. At the end of the reference swath, turn toward the second swath and 
continue Snap-to Swath. 

 
• Seed: Seed Swathing is much like Snap, except that the operator has the option to 

press the “recal” button to correct for drift error. Press the “Set A: button to begin 
Swath #1. Continue to drive to the end of Swath #1, then press “Set B”. Guidance 
will be based on the original A-B points until the “recal” feature has been used. 

 

Troubleshooting 
Troubleshooting Your GPS Receiver and Site Mate 
 
What does all of that mean on the GPS Settings – Quality tab of Site Mate? 
 

Minimum GPS Quality – This refers to the quality of signal that Site Mate will 
use to log. If Site Mate sees anything below the selected quality, it will not log. 

 0 = No GPS Position 
 1 = GPS position only 
 2 = GPS position with differential (WAAS for example) 
 4 = RTK fixed position 
 5 = RTK float position 
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Maximum HDOP – This option allows you to filter positions and minimizes the 
occurrence of logging distant points if GPS signal is lost. The recommended 
setting for maximum HDOP is 25. 
 
Honor NMEA Checksum – Check this box to throw out any points that have an 
incorrect Checksum. 

 
What does that message mean at the bottom of my Site Mate screen? 
 

There are 4 possible messages you can see at the bottom of your Site Mate screen: 
 

1. Actual GPS Coordinates - This tells you that you are receiving a GPS signal and 
you are ready to use Site Mate. 
 

2. Unable to Open Comm Port for GPS data -  This means that something is 
accessing the current port selected within the GPS Settings. 

 
a. Double check your GPS Settings. Go to the Config tab – Settings – GPS 

Settings. Make sure the correct port is selected here. 
 

b. If the correct port is selected, what else has been connected through this 
port? Sometimes external keyboards, other GPS programs, Active Sync, or 
other external hardware devices can be accessing the port even though it is 
no longer connected. 

 
Possible Solutions: 

• Soft reset the hand held and go directly to Site Mate. 
• Change the GPS Settings within the program or hardware drivers. 
• Remove any drivers or programs used for other devices through Start – 

Settings – System – Remove Programs on the hand held device. 
 

3. No GPS Data Received – This can mean one of several things. 
 

a. GPS receiver is not receiving power. 
 

Note: if using an IFB box with a non-Raven receiver, you will need a special 
power adaptor to power the IFB and in return, send GPS signal to the hand 
held. 

 
b. NMEA – The GPS receiver must be configured to output NMEA strings. 

The GPS receiver also must output NMEA 0183 strings. At a minimum, it 
needs to output the GGA and VTG strings. 

 
c. Incorrect Baud Rate is selected within the GPS Settings. Double check the 

GPS Settings within Site Mate. You can also use the Auto-Baud feature. If 



Farm Works Mate X2 Reference Guide 

72 

there is a GPS signal present, Site Mate will search all of the comm ports 
and baud rates until it finds it. 

 
4. Cabling Issue. If the incorrect cabling is being used, Site Mate will display this 

message as well. 
 

5. No Message at all. Occasionally, the area at the bottom of Site Mate will be blank. 
If this happens: 

 
a. Go to the Config tab – Advanced Logging Options. If an IFB box or 

implement switch is not being used, make sure the box is not checked 
beside Enable Implement Switch. 

 
Why is nothing being logged in Site Mate? 
 
Several things can prohibit Site Mate from logging data. If you encounter this problem, 
try the following: 
 

1. GPS Signal – Make sure you have a good GPS Signal. Go to the Data tab within 
Site Mate. How many satellites are being used? What is the signal quality? 

 
2. Manual Logging – Make sure Manual logging is not activated. (If a Log buttons is 

appearing after you tab Go, manual logging is turned on.) 
 

3. Zoom Status – If you are zoomed too far out or are scrolled off of the screen, you 
will not be able to view your data. Use the zoom tools to zoom in on your current 
position. 

 
a. Check/uncheck the options to auto scroll and auto scroll and zoom on the 

log menu. 
 

b. Tap on the zoom in / zoom all buttons at the bottom of the map tab. 
 

4. Check the settings on the Config tab. 
 

a. Minimum GPS Quality – Go to Settings – GPS Settings – Comm tab to 
check this setting. 

 
i. Set this at 1. This will allow Site Mate to log data as long as you 

are receiving a GPS signal. 
 

ii. If this is set at 2, data will not be logged unless you are receiving 
differential (WAAS). 
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b. Enable Implement Switch – Go to Advanced – Advanced Logging 
Options on the Config tab to check this setting. If you are using Site Mate 
Basic, it will be found under Advanced – Implement Switch. 

 
i. If you are not using an implement switch, this option should not be 

enabled. 
 

ii. If you are using an implement switch, make sure the appropriate 
option is selected beneath this setting. 

 
iii. If using an implement switch, make sure the logic is correct. If it 

logs while the implement is up or off, check the option to reverse 
the implement switch logic. 

 
c. Recording Interval – Go to Logging – Auto Logging on the Config tab 

 
i. Enter the minimum time and distance required for logging data. If 

both requirements are not met, data will not be logged. 
 

ii. A typical setting is 1 second and 10 feet. 
 

d. Display – Select the appropriate mapping option (path, points, or 
boundary) below Display on the Config tab to check this setting. 

 
i. Boundary or Points – Make sure the appropriate option is selected 

here. If wanting to log the actual path or boundary only, check the 
actual box. If using an offset and the offset path or boundary is all 
that is wanted, only check offset. If you want to log both, check 
both boxes. Also verify the line width and color. 

 
ii. Points – Enlarge the point size to see if previously logged points 

become visible. 
 
Why do I only see a line or a blank screen on the map tab of Site Mate? 
 

Maximum HDOP – To reduce the chances of this happening, change this setting 
to 25. 
 
Occasionally GPS receivers can lose GPS signal, causing Site Mate to lose 
position. If this happens, even for a moment, your position in Site Mate will 
bounce to the coordinates 0,0. Once the GPS receiver acquires GPS signal again, 
Site Mate will locate your position and bounce back to the current location. When 
this happens, Site Mate will draw a line to or log a point at this 0,0 coordinate, 
creating a stray line or an unwanted point far away from your desired map. 
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VRA Controller Setup 
Supported Controller Types 
 
The program supports a wide range of variable rate controllers. The list of supported 
controllers is always growing. If you do not see your controller on this list, contact your 
software provider and we will work to add your controller to a future version. 
 
AGCO Falcon  
AGCO Fieldstar  
AL 2000 Yield   
Amazone Amaspray+ ASD  
Amazone Amados+ ASD  
Amazone Amatron II  
Amazone Amatron IIA  
Amazone Amatron+  
Axiomatic For manure application 
Bogballe  
DGH Counter  
Dickey John Dry, Liquid, or NH3 
EM38  
Farm Scan  
Flexi-Coil  
Grain Scan  
Green Seeker  
Hardi International  
Hardi Mustang  
Hiniker  
John Blue  
Kverneland  
LH-Agro Sprayer, Fertilizer, Drill or Slurry Spreader 
Micro-Trak  
Micro-Trak Yield  
Mid-Tech Granular or Liquid 
New Leader Including Mark III & IV 
Raven Versions A-H or J, Granular or Liquid 
Rawson  
RTS On/Off  
Squibb-Taylor  
TeeJet  
Veris 3-Speed  
Veris EC  
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The Controller tab in the Variable Rate Setup box is used for entering additional 
information required for several of the compatible controllers. Some controllers do not 
require additional information to be entered on the Controller tab. These include 
Amazone, Axiomatic, EM38, Farm Scan, Hardi International, Hardi Mustang, John Blue, 
Kverneland, Micro-Trak, RTS On/Off, Squibb-Taylor, and Veris EC. 
 
The required information is listed below by controller: 
 
AL2000 Yield 
 
Enter the Combine Flow Delay, Start Delay, and Stop Delay. Consult your combine 
owner’s manual for this information. 
 
Check the box for Log raw monitor data (.dbg file) if desired. 
 
Bogballe 
 
Select the correct version – BC2002 or BC2003 
 
DGH Counter 
 
Select Event Counter or Current Meter. Enter the pulses/gallon and the number of 
positions to use in smoothing (1-10). 
 
Dickey John 
 
Select the Channel Type – dry, liquid, or NH3 
 
Flexicoil 
 
Enter the number of channels and select the channel you will be controlling with Site 
Mate. Place the red check mark next to the desired channel. 
 
Grain Scan 
 
Enter the Baud Rate for the controller and check the box next to Create raw text output 
file (dbg) if desired. 
 
Green Seeker 
 
Check the box next to Raw text file output (.txt) if desired. 
 
Hiniker 
 
Check the box next to Use Snap Shot Reply for versions 2.03 and higher. 
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Micro-Trak Yield 
 
Enter the weight of the crop per bushel as well as the Dry Moisture %. Check the box 
next to Raw GeoMarker Output (.dbg file), if desired. 
 
Mid-Tech 
 
Select whether the application is granular or liquid and the correct Datalink for your 
controller. If using Ver 5, make sure the correct baud rate is selected. Make sure the red 
check mark is next to the channel that you will be controlling with Farm Site Mate. 
 
New Leader 
 
Enter the Nominal Rate. The Nominal Rate is an average of the rates that are included on 
the Rx map. 
 
Raven 
 
Enter the number of channels. Select the channel that you will be controlling by tapping 
in the Var. column next to the appropriate channel. The red check mark should be 
displayed next to the channel that you will be controlling. Select whether this application 
will be liquid or granular as well as the correct Revision. 
 
Rawson 
 
Enter the Nominal Rate. This is the average of the rates that are to be applied. Select the 
Step percentage. This value must match the Step that is being used on the controller 
itself. 
 
TeeJet 
 
Select the model – 844 or 854. Users will also select the desired Units. 
 
Veris 3-Speed 
 
Enter the Nominal Rate. This is the average of the rates that are to be applied. Also, enter 
the Step percentage. This value must match the controller. 


